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					Your frequently asked questions – and our solutions

Our technical support team has been asked lots of questions by Allplan users over the years and our solutions have been stored in a knowledge database.

As a Serviceplus customer, you can search the full database for the answers you need.


					





				

			
		


	




	



































                Search
            

	


	
		
			
				
					
						
					
					
					
					

					
						
							Your search phrase: 
						

						
							
								
								
										
									
							

						


						
							or Browse by Category

							 Please select
AEC 
Allplan 
Bimplus 
Licensing 
More products 





						

					


					
					
					
					

				


				
					
						

	
		


Support Filter

    
        
            Allplan 2024
            
                 (60)
            
        
    
        
            Allplan 2023
            
                 (66)
            
        
    
        
            Allplan 2022
            
                 (66)
            
        
    
        
            Nevaris
            
        
    
        
            Precast
            
                 (1)
            
        
    
        
            Visible to all users
            
                 (111)
            
        
    
        
            Visible for customer
            
                 (111)
            
        
    



	


					

				
			

		

	















                Result
            

	
	
	
	
			
					
						Recommended Knowledge Article(s)
						

					
					


	
		111 results:

		







	


	
		
	





	
		
			








	
		
			
				
					
					Options window / IFC window closed immediately when opened
				

				

			


			

				
					
						  Link
					
					

					
					

				

			

		

	


	

		
			
				
					Version: 
					Allplan 2016, Allplan 2018, Allplan 2017

				
				
				 | Last modified: 27.02.2024 14:59
				
			

			
				
						 

							
								
							

						 rate

						

					
			

		

		
			

			Question:

The windows for options and the window for IFC import and export are closed immediately when opened. How can this issue be solved?



Answer:


1. HP computer

If you are using an HP (Hewlett-Packard) computer, please take these steps. Otherwise proceed to number 2.

Check whether the security software "HP ProtectTools" is installed on this computer. If yes, then uninstall "HP ProtectTools". This software suite consists of several progams. In most cases, these programs are:

	HP ProtectTools Device Access Manager
	Embedded Security for HP
	Face Recognition for HP ProtectTools
	File Sanitizer For HP ProtectTools
	Privacy Manager for HP ProtectTools
	Theft Recovery
	Drive Encryption for HP ProtectTools
	HP ProtectTools Security Manager



It is possible that more or less HP software than the listed is installed. When you uninstall the "HP ProtectTools Security Manager", no other dependent software should be listed during uninstallation.

If there is dependent software listed during uninstallation, please uninstall these programs first. As the last step, "HP ProtectTools Security Manager" should be uninstalled. 

An example message, listing dependent software which is still installed:





Important notice: Please restart the computer to complete uninstalling the software.




2. Dell computer

If you are using a Dell computer, please take these steps. Otherwise contact the Allplan support.

Check whether the security software "Dell Data Protection" is installed on this computer. If yes, then uninstall "Dell Data Protection". This software suite consists of several progams. In most cases, these programs are:

	Dell Data Protection | Security Tools Authentication
	Dell Data Protection | Security Tools




It is possible that more or less Dell software than the listed is installed. When you uninstall the "Dell Data Protection", no other dependent software should be listed during uninstallation.

If there is dependent software listed during uninstallation, please uninstall these programs first. As the last step, "Dell Data Protection" should be uninstalled. 

An example message, listing dependent software which is still installed:





Important notice: Please restart the computer to complete uninstalling the software.




Notes: 

HP ProtectTools Security Suite was developed by McAfee in cooperation with HP. It is pre-installed on most HP business notebooks and on some HP desktop computers.

HP ProtectTools are using  Full Volume Encryption (FVE) by McAfee Safeboot, which changes the Win32 API behaviour. This causes problems in Allplan.

Also Dell is using similar mechanisms for the Dell Data Protection Suite. They have the same influence on Allplan.

Please note that these programs in either case have negative effects on stability and functionality of Allplan, even if you might not notice it (example: working options and IFC windows in different Allplan version).
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			Question:

What license issues do I need to consider when upgrading from Allplan 2019/2020/2021 to Allplan 2022?


Answer:

Installation options during Setups

Upgrade - program update with transfer of all project data, office and user settings.
The existing Allplan installation is upgraded to version 2022. If several Allplan versions are installed, only the latest version will be suggested for upgrade.  Projects, office and user settings are automatically transferred from 2019/2020/2021 to Allplan 2022. Allplan 2019/2020/2021 is then no longer available.

New installation without transfer of project data, office and user settings: 
Existing Allplan installations remain unchanged. Office and user settings are not transferred to version 2022. You can import projects after installation using the following Allplan function: 
New project, open-> Import projects.

New installation with transfer of office and user settings:
Existing Allplan installations remain unchanged. Office and user settings are automatically transferred from 2019/2020/2021 to version 2022. In the case of multiple installed Allplan versions, only the most current version is suggested for transfer. If you have installed with a central file store, make sure that you create a folder with a suitable share on your central file store (server) beforehand. This folder can then be selected as the "central file storage folder" during setup. You can import projects after installation with the following Allplan function: 
Project new, open-> Import projects.



Depending on the licensing system you use, you need to consider different points.

There is no license request when installing Allplan 2022. Therefore, make sure in advance that your licenses are also suitable for this version, e.g. by purchase or a valid service contract.

1. Upgrade Allplan 2022 – stand-alone workstation 

Your license for Allplan 2022 will be updated after installation, when you start Allplan 2022 for the first time. Start Allplan 2022 and you will be prompted to update the license. Select "Update now" here. The license is updated online. You can then start Allplan 2022 directly or close the license window. 

Note: To install Allplan 2022 on a new computer, please read on connect.allplan.com/license within the menu item Information on Installation and Licensing the instructions Transferring license to a new computer.

You can find your Product Key in Allplan Connect as usual. Go to: connect.allplan.com/license

2. Upgrading Allplan 2022 with a license server 

Start by updating your license(s) at the license server. After this, upgrade the clients. To do this, start the License Settings program on the server. Click License Activation on the left, and then click the license you want to update. Click Update License.
After the license(s) update, you can perform the Allplan upgrade installation on the client computers.

NOTE: Check the version of your installed license server on the server. Starting with the license server version 2016-1-4, the detailed version status (Build-ID) is displayed directly in the lower left corner of the License Settings program.
At least version 1.1196.xxx.xxx should be displayed here. If an older Build ID is displayed, then you still have an older license server in use. In any case, please update your license server. Download the software for the license server from the Allplan Connect service portal. Detailed instructions can be found at connect.allplan.com/license under the menu item Information on installation and Licensing' and the instructions 'Updating license server and licenses'.

Note: You can update the licenses only at a license server you have already installed. If you want to switch to Allplan 2022 and move the license server to a new server, please read on connect.allplan.com/license within the menu item Information on Installation and Licensing the instructions Moving license server to a new server.

You can find your Product Key in Allplan Connect as usual. Go to: connect.allplan.com/license


Downloading licenses from Allplan Connect 
You can also obtain your activation codes for Allplan 2022 IBD in the Allplan Connect service portal. 
To do this, click Profile > License Management.
You can only use this function as an administrator.
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			Question:

Which graphics cards are recommended for Allplan?



Answer:


Follow this link to see a list of the AMD/ATI & NVidia graphics cards manufacturers that are CERTIFIED FOR ALLPLAN. 
We have tested the OpenGL functionality and the animation performance of various Allplan modules with specially prepared data with each of the cards available.
https://www.allplan.com/services/cad-software-support/grafikkarten.html

The tested drivers can be found on the homepage of the individual manufacturer. The driver versions that were used in the tests are included in the tables so that you can compare the data. However, we strongly recommend that you always installthe current driver of the manufacturer.

It is a good idea to check your system using the system tool you can find on our homepage:
https://www.allplan.com/services/cad-software-support/downloads.html



Additional information: 

Allplan 2011 was revised completely for accelerated graphical representation. 
To guarantee full performance support for Allplan 2011 and later, please check that your graphics cards meet the hardware requirements for DirectX 10 & OpenGL 2.0 (chip-based). In addition, you need to install the current drivers.  Allplan will automatically switch to the conventional drawing method when it starts and finds old graphics cards that do not meet the requirements stated above.  

For more information on graphics card specifications, go to

http://en.wikipedia.org/wiki/Comparison_of_AMD_graphics_processing_units
http://en.wikipedia.org/wiki/Comparison_of_NVIDIA_graphics_processing_units#Quadro)



Note:

We kindly ask you to understand that products of other manufacturers that are not mentioned have not been tested and therefore cannot be recommended.
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			Question: 

How can I remove NemSLock completely from a computer?



Answer:

Do the following:

	Uninstall Softlock 2006 by clicking Start  -> Control Panel -> Programs and Features.


	
	
Select "Nemetschek SoftLock 2006" and then click "Uninstall/Change". Select "Remove" -> Next -> Yes.

	Extract the "NSLFixer2006.zip" file attached and copy it to any folder on your computer. If your email provider or firewall software has blocked this file, you can also download it from our webdrive. Use this link: 

https://webdrive.allplan.com/index.php/s/4LrjrymoxESzC6p

The tool "NSLFixer2006.exe" is under Allgemein/Nemslock

(click on the right hand side next to file size on the three dots and chose 'herunterladen')


	Start NSLFixer2006.exe by double-clicking it. 
Important note:
If you are running Windows Vista or a newer operating system, click the program with the right mouse button and select "Run as administrator". Confirm the following message.

	Create the key by clicking "Generate/Enter a key" (1).


	

	Select the line to the right of "Generate/Enter a key" (2), "1F02E74917D3F6E7348C1F02E74917D35E2599A254864A233C549A25ADD2EDFD", for example, and press "Ctrl+C". Paste this key into an email and send it to "support.de@allplan.com".

	We will send you another key. Please copy this key to the second line (3). If you need to restart the program, paste the key you created into the first line (see step 3, do not click "Generate/Enter a key" again!). Then click "Validate twin key" (4). After you have done this, you should see the following message: "System cleaned. Reinstall NemSLock".

	Update your current Allplan version. Use the temporary license file ("psd" can be found in its file name). You can also find your current temporary licenses at www.connect.allplan.com. Go to "Profile -> License administration".
Students should use the Allplan Setup program which they can download from Allplan Campus (http://www.allplan-campus.com -> log on -> select "Software" at the top -> download Allplan). Use the trial license provided by Setup.



After this, request a new license by sending a new registration request (Services application -> Utilities -> License -> License Manager). Select the license entry for your seat and click "Request license". 
If you work with a license server, reconnect the client with the server.
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			Question:

ProjectPilot does not open, displaying the following error message:
“Unable to create ProjectPilot control. Is the registry correct?” What can I do?



Answer:

Step 1
Start the Services application -> Service -> Windows Explorer -> CAD program folder.
Open the "PRG" folder.
Find the following file: "NemProjectPilot10.exe"
Right-click this file -> select "Run as administrator" on the shortcut menu.
Try to start ProjectPilot from Allplan.
If ProjectPilot does still not start, go to step 2.


Step 2
Check whether updating the software of the virus scanner solves the problem.
If it doesn't, configure the real-time scanner of the virus scanner so that
it no longer scans the program folder and data folder of Allplan.
Start the Services application: Make a note of the following paths displayed in the Services application window:
Program folder
General program data
Central file storage folder
Define these folders as exemptions in your virus scanner.
If ProjectPilot does still not start, go to step 3.



Step 3
This problem is often caused by an "external path" that no longer exists. When you start ProjectPilot,
the program tries to access the "external path", which is stored in the Windows Registry.
If this path no longer exists, you will see the above error message.

To correct this error, do the following:
	Start the Services application -> Service -> Windows Explorer -> My own CAD documents (USR).
	Find the "extern.cfg"file in the user folder and delete this file.


If ProjectPilot does still not start, go to step 4.



Step 4 (Windows 10 or later)
Open the PRG folder of Allplan in Windows Explorer (for example, C:\Programs\Allplan\Allplan 2018\prg).
Start the Services application. The folder you selected for the Allplan program during installation is displayed directly in the Services application window.
Right-click the "NemProjectPilot10.exe" file in the Allplan program folder. A shortcut menu opens. Click “Properties”.
Open the “Compatibility” tab and select the “Disable fullscreen optimizations” option. After having selected this check box, click “Apply” at bottom right.





If several users with different user profiles use Allplan on this computer, click the “Change settings for all users” button first. Then, disable fullscreen optimizations as described above.





If ProjectPilot does still not start, go to step 5.



Step 5
Fix Allplan.
To find out how, go to
https://connect.allplan.com/en/faqid/20120917082945.html
After installation, try to start ProjectPilot.
If ProjectPilot does still not start, go to step 6.



Step 6
If ProjectPilot does still not start, the most likely cause of this problem is security software such as the virus scanner.
Remove, that is, uninstall the local virus scanner with all its services from the Allplan computer having these problems.
After this, ProjectPilot will start.
To reinstall the security software or virus scanner with its appropriate settings,
contact the support service of the software provider.
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			Question:

How can I change the cache path for Allplan Share?

Note: 

You do this at your own risk. 
We strongly recommend that you clarify all issues in advance. 
Always copy a file before you change it.
Before you change registry entries, back up the registry key that you want to modify. To do this, export the key by selecting File - Export in the Registry Editor.

Answer:

Allplan Share temporarily saves the project data in the path of the local file storage, which you defined when you installed Allplan.
You can see the path of the local file storage folder in the Services application.
If this folder is centrally on a server for all Allplan workstations:
To avoid replication conflicts that might occur when several users work on the same project data, you must change the path settings for each user so that this folder is locally on the user’s computer running Allplan.

Before you start, close Allplan, making sure that you do not lose any data.
	Go to a local drive (C or D) of the computer running Allplan and create the new "Local data” folder with the "Allplan” subfolder (for example, C:\Local data\Allplan).
	Start the Windows Registry Editor as the administrator (start - run - regedit).
	Go to the left column of Registry Editor and open the following key: HKEY_LOCAL_MACHINE\SOFTWARE\Nemetschek\Allplan\2018.0\InstallRoot. If Allplan 2019 or a newer Allplan version is installed, “2019.0“ or the newer version replaces “2018.0” in the path.
	Go to the right column of Registry Editor and double-click theLocalDataDrivekey. Specify the drive that you selected for local file storage (for example, C:). Then click OK to confirm the change. This applies the change.
	Then, go to the right column of Registry Editor again and double-click theLocalDataPathkey. Specify the path that you defined for local file storage (for example,\Local Data\Allplan). Then click OK to confirm the change. This applies the change. The result should look like this:


	Close the Registry Editor. Allplan now uses the new path for the cache of Allplan Share.
	Start Allplan and select the Allplan Share project to load the necessary project data into the new cache.
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			This FAQ is valid from 24.04.2023, from then on a new Allplan Exchange Online Service will be available to you.

 

Question:

 

I would like to start with Allplan Exchange. 
First steps in Allplan Exchange work.

 

 

 

Important note : 

 

Before you start with the first steps in a new system, it is good for you to know whether the data can also be deleted. The answer to this is YES. When you start saving your first projects and documents online, you can delete them after a test run.

 

It is up to you to delete the centrally stored data at any time; with the deletion, access is withdrawn from the project participants.

 

 

 

Answer:

 

The following simplified representation shows that some steps are carried out once and further steps are repeated for each project.


 

 

(1) REGISTRATION (Login):

 

By registering in Connect, you will receive a valid USER account for all our online services (such as BIMPLUS and EXCHANGE) , allowing you to log in to Exchange:

 


https://exchange.allplan.com



 

 

Logging in should be possible in any case if you have a USER account.
The use of your own COMPANY account depends on your licence.
If you are unable to continue from here, please contact your

 

sales partner : LINK = https://www.allplan.com/de/beratung-verkauf/vertriebspartner/

 

If you already have a licence, you can continue with the next points

 

 

 

(2) COMPANY MEMBERS: 

 

The first user is automatically authorized to invite members to the Exchange account and to define their roles in the Exchange account.
a) In the main menu, select "PROJECTS" | b) select the "INFO BUTTON" | c) here you will see the list of your current MEMBERS | d) you can add more by clicking on the ADD MEMBERS button | e) simply enter the email address, select a language (from the recipient) and a COMPANY ROLE, click on "Send" to finalize the invitation




The newly invited member will receive an email and can complete the registration of his personal account.

 




 

 

Remove member : 

 

If you want to remove a member, simply click on the icon with the cross (see picture #f) in the corresponding line. A member will then be removed from your company account and will also be removed from all projects in your company account so that the former member can no longer access your data.

 



(3) PROJECT:

 

The first project can be created online:

 

a) In the main menu, select "PROJECTS" | b) Select the icon for "CREATE NEW PROJECT" | c) Enter a name e.g. "MY FRIST STEP" and click on Create | d) You will receive a message that a new project has been created | e) You will find the new project in the overview,
TIP: You have automatically been created as a project participant with the highest project role "Manager" and can therefore continue with step 4.



Delete project : 

 

If you want to delete a project, simply click on the icon  (see image #f) in the corresponding line. The project will be deleted along with all existing documents, so you and any Project members will no longer have access to the project data. Please note that this step cannot be undone. 
You will be see a message and must explicitly confirm that you have taken note of this.

 

 

 

(4) PROJECT PARTICIPANTS:

 

You can select the project participants from the group of company members (already created under point 2); by entering a name or email you will automatically receive default values. Select a company member and assign a project role at the same time.

 


a) In the main menu, select "PROJECTS" | b) Select a project from your account. | c) Switch to the "PARTICIPANTS" tab | d) Click on the "Add project participants" function | e) Simply enter the name or email here, you will receive default values for selection, at the same time you can select the corresponding project role and click on "Add" | f) In the list of project participants you will also see their role, which can be changed at any time.
The project participants now have access to the project and all plans that you will send to the project participant.




 

 

Remove project participant : 

 

If you want to remove a project participant, simply click on the icon with the cross (see image #g) in the corresponding line. A project participant is then removed from the project assignment and can no longer access the project data.

 

 

 

(5) PLAN DISTRIBUTION:

 

LOGIN: Now start Allplan CAD and open your desired CAD PROJECT. a) Switch to the Plan layout area | b) Start the "Allplan Exchange" function | c) The Allplan Exchange dialogue opens | d) Click on "Log in" to use the advantages of the Allplan Exchange online function | e) In the login dialogue, enter the same login data as on the website| f) When logging in to this CAD project for the first time, you will automatically be asked for the assignment, select the desired Allplan Exchange account and the PROJECT previously created online, e.g. "MY FRIST STEP".

 




a) LEFT: select the plans to be exported from the plan overview | b) MIDDLE : define the file formats for each recipient | c) RIGHT: see the expected results of your selection for each recipient.  | d) Click on EXPORT to create the file formats and send them immediately.




 

 

(6) DOWNLOAD:

 

The recipients automatically receive an email notification and are authorised to download the plans centrally online and at the same time the plans are automatically versioned.
In the "INBOX" overview, every registered recipient can download all the documents that have been sent to them. 
And this is how the download works:

 

a) A recipient can log in to Allplan Exchange on the website | b) The INBOX is the first page you see after logging in | c) Individual or multiple entries can be downloaded - simply select them | d) and click on DOWNLOAD e) A message informs you of the successful action f) The icon in the table visualizes via the color change whether the entry has already been downloaded or not.




 

 

(7) REPORT:

 

Allplan Exchange records all history information for each file, e.g. : Upload, sender, recipient and download.
A project-related report output clearly shows the history of all plan versions, their history and their history information.

 

a) In the main menu, select "PROJECTS" | b) Select a project from your account. | c) You are automatically on the overview of the project documents, select the button "REPORT" | d) The report opens in another browser tab and you can see the entire project history. You can print this display with the usual browser functions or save it as a PDF.

 




(8) DELETE DATA:

 

The following data deletions can be found in the corresponding sections 
	Remove company members, see section (2) COMPANY MEMBERS
	Delete project, see section (3) PROJECT
	Remove project participants, see section (4) PROJECT PARTICIPANTS
	Individual documents or document versions can be found here in this section

 

 

 

Delete documents including all document versions

 

a) In the main menu, select "PROJECTS" | b) Select a project from your account. | c) You will automatically be taken to the overview of project documents | d) Select the document or several documents to be deleted | e) Select the button with the three dots and the DELETE option | f) You will receive a message that the document including its versions and history information will be deleted. Please note that this step cannot be undone.




 

 

Delete a single document version

 

Now you only have to navigate down one level more, but the principle is the same as when deleting a document, except that only one version is deleted here. This is useful, for example, if you have accidentally uploaded something and only want to remove these versions from distribution.

 

a) In the main menu, select "PROJECTS" | b) Select a project from your account. | c) Y You will automatically be taken to the overview of project documents | d) Click on the document containing the versions | e) A side panel opens | f) Here you will find the "Versions" button | g) For better orientation, the breadcrumb menu also helps you and shows which document you have selected | h) Now select the version to be deleted "e.g. Index C" | i) Select the button with the three dots and the DELETE option | j) You will receive a message that the document version including its history information will be deleted. Please note that this step cannot be undone.



 

 

We hope you have fun with Allplan EXCHANGE
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			Question:

I just installed an upgrade. How can I convert all the projects at once?



Answer:

Back up all the projects beforehand!

Do the following:

	Exit Allplan on all workstations.
	Only when working with Workgroup Manager:
Log in as the Allplan administrator (sysadm).
	Start the Services application.
	Only when working with Workgroup Manager: 
Make sure all the computers where projects are located are up and running.
To check this, select:
Services application -> Workgroup Manager -> Information -> Display Project List(the second column displays the computer where the project is located).
	Go to the computer where you want to convert the data and set the drawing file size to the maximum value:
Services application->Service ->Hotline Tools->docsize ->512 (or 1024, if available) ->OK
Note:
After data conversion, you can set the drawing file size back to the initial value.
	Start converting the data (use the computer where you have changed the drawing file size):
Services application ->Service ->Hotline Tools -> datwaprjs: convert data of all projects
If you reply "Yes" at the following two prompts, the program will convert the data of all projects.




Notes:

The time it takes to convert the data depends on various factors:
	Number of projects
	Size of each project
	Performance of the computer converting the data
	Network performance


It is possible to start data conversion from several workstations at the same time.
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			Question:
Which server or server operating system can be used for data storage of Allplan.

Reply:

Since Allplan 2018 we recommend Windows Server 2016 as the server operating system for pure data storage and since Allplan 2019 also Windows Server 2019, since Allplan 2022 Windows Server 2022.
When selecting the server operating system, please also take into account the interaction with the client operating systems used. 
For Windows Server 2012 R2, the "development phase" (fixing bug fixes, etc.) was discontinued in 2018. 
However, Microsoft will continue to provide extended support (closing security gaps) until 10.10.2023. 
The same applies in this respect for the Windows 8.1 operating system used in the same period.

Due to this fact, it cannot be ruled out that the further development of the Windows 10 operating system and the "technological standstill" of Windows Server 2012 R2 could lead to discrepancies when combining these operating systems at some point. 

However, Microsoft should be able to guarantee compatibility for the operating systems used in the future.
Windows Server 2016 - Windows 10 
Windows Server 2019 - Windows 10
Windows Server 2022 - Windows 10 and Windows 11 respectively.

If Allplan is also to be installed on the server operating system (e.g. Citrix), the corresponding release in the system requirements must be observed. For Allplan 2016/2017 this is e.g: Windows Server 2012 R2. For higher Allplan versions this is e.g: Windows Server 2016.

General information about the system requirements here:
https://www.allplan.com/en/system/system-requirements/


Notes on NAS systems: 
NAS server are not generally recommended. Because the product variety and quality is very diverse, no effective quality control can take place. We can give no guarantee about operability. In the past we had performance or stability problems, false representations up to the loss of data in some cases.
This phenomenon occurs most in NAS systems of the lower price segment, which have not installed sufficiently fast hardware. If nevertheless a NAS system is to be used we recommend generally a high-performance hardware and the use of the operating system "Windows Storage Server 2012".
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			Question:

Allplan starts as a viewer. What can I do?



Answer:

Do the following:

1. The Allplan license folder contains the servcfg.nse file. 

Open this folder: 
Services application -> Service -> Windows Explorer -> General program data (ETC, LIC) -> License.

Delete the servcfg.nse file from this folder.

2. Install the new, appropriate license, which you can find in the attached file. Save the license to a folder on your computer and install it as follows:
Services application -> Utilities -> License -> Install HARDLOCK License

3. Check that the light indicator of the connected USB dongle (blue or white stick) is on all the time. To test it, you can connect the dongle to a different port.

4. Install the current hardlock driver if the light indicator is off.
You can find detailed instructions here:


https://connect.allplan.com/en/faqid/20131028125253.html

5. Select the Services application -> Utilities -> License -> License settings ->  Licenses.
Check if "Allplan FT" is displayed in the white window on the left. If this is so, Allplan has accepted the dongle. 

If this is not so, send the logmes.nse file, info.001 file and the new servcfg.nse file (license folder) to support.de@allplan.com
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			Question:

How can Allplan be operated under a QHD / UHD / 4K resolution?


Answer:


Starting with Allplan 2018, a query will appear in the Allplan Start under a QHD / UHD / 4K resolution (from 2560 x 1600), in which you can decide whether the operating system scaling should also be used in Allplan. This choice can be changed at any time in the Allplan Options-> Desktop Enviroment- > Display-> Scaling of the user interface.

Note:

If this option is switched on, Allplan uses the scaling level, which is set globally in the display settings of the operating system. Side effects of this scaling can be slight blurring in the symbols, drawing elements, and dropped graphics in Allplan.
Please note that this functionality is only available from Windows 8.1 and higher.
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			Question:

How can I export data from the layout editor so that Allplan creates a layout DWG and an additional reference DWG for each drawing file?



Answer:

As opposed to Allplan, AutoCAD only provides one model space. You cannot work with various drawing files as usual in Allplan. Using external references, however, you can load parts of different DWG files into one DWG file.    
The "exporting complex data with external references" method is particularly useful for exporting data from Allplan's layout editor. 
With this method, a master drawing (layout DWG) is created from the layout and additional reference drawings (reference DWGs) are created from all the drawing files placed in the layout. All these reference drawings are associated with the layout DWG and thus also visible there. These files only contain the AutoCAD model space. 

Export:

Select the layout you want to export in Allplan's layout editor:
	Select File -> Export-> Export AutoCAD Data.... Select the relevant layout and click OK to confirm.
	A dialog box opens. In the Save inarea at the top, select the folder where you want to save the exported file and select the required file type.
	Click Options... and set the required options on the 'General Settings'tab. In Allplan 2009 and later, for example, you can select the exchange favorite 3 as the basis for the export and set the other options manually.
Open the 'AutoCAD specific'tab. In the 'Part of file to be transferred'area, select the Design (model space)check box.
If necessary, define additional settings in the options and confirm them by clicking OK.
	Then start the export by clicking Save.
	The "Export:..." dialog box opens for the layout. Click the Modifybutton if you want to change the configuration. While exporting the data, Allplan displays the "Export:..." dialog box for each drawing file used.
	Allplan creates one layout DWG and an additional reference DWG for each drawing file.


Result:

1. Files created:
Allplan creates a file for the layout (e.g., "plan_1.dwg") and an additional file as an XRef for each drawing file placed in the layout (e.g., "tb_1.dwg", "tb_2.dwg" and so on).
When you open the layout DWG (e.g., "plan_1.dwg") in AutoCAD, the reference DWGs (e.g., "tb_1.dwg", "tb_2.dwg" and so on) are displayed as external references. 

2. Resolving elements: 
Elements in drawing files are transferred as complex elements (e.g., hatching, patterns and dimension lines are retained).
Elements that are directly in the layout are transferred as complex elements or they are resolved, depending on the settings in the 'Explode elements'area.

3. Filtering elements: 
The filters in the 'Transfer elements'area apply not only to the data that is directly in the layout but also to the data of the drawing files. 

4. Construction lines:
Using the filter for construction lines in the 'Transfer elements'area, you can filter construction lines both in the layout and in the drawing file. In the 'Transfer elements'area, switch off the Construction linesor Not plottable elementoption (same effect).

5. Clipping boundaries:
A clipping boundary is an area that is cut, for example, by a layout window. Clipping boundaries are taken into account. 

6. Allplan structure:
Allplan creates a separate DWG for the layout and for each drawing file and transfers the drawing file structure in this way. The layers of the drawing files become the layers of the DWG.

7. Paper space – model space: 
With this method, the model space is transferred in each DWG.



Note: 

If your planning partners do not want to work with several DWG files in AutoCAD, they can integrate the reference DWGs into the layout DWG and thus work with a single DWG file.
To make sure that the data is referenced correctly when the DWG file is opened, you need to save all the files in a common folder and transfer this folder.
If you have any further questions regarding data exchange, this topic is described in detail in the online Help. All you need to do is press the F1 key. Open the Index tab and selectInterfaces.
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Question: 
How can I work together on a project with a partner from another country?
	Answer:
Using Allplan 2019 and later, you can work on projects across countries.	You can define projects in a country-specific manner. This means that a project gets the resources (for example, hatching, patterns, layers and so on) and reinforcement settings of a specific country. Depending on your license, you can install one or more additional country packages. For example, you can then create a project with resources and settings for Germany and another one with resources and settings for the UK.


Requirements:Whether you can use country packages depends on the Allplan license.
Only the ‘Cubed’ and ‘Exponential’ license types include country packages. 
These license types enable you to use as many country packages as you like. You can create and open projects with any country code.
The ‘Lineared’ and ‘Squared’ license types only include one country package by default. This also applies to all conventional license types such as ‘Architecture’ and ‘Engineering’. In other words, you can only create and open projects with this country code.

Installing country packages:
When installing Allplan 2019 for the first time or upgrading from Allplan 2018 or earlier, you must explicitly install the additional country packages.
A default installation onlyinstalls the country package of your country. If you want to use different country packages, you must do a custom installation. Only a custom installation allows you to select the country packages you want to install. 
You can do this whenever you want - be it the first installation or an upgrade or update.

Doing a custom installation:
Start Setup.
Select Customfor the Setup type.
When it comes to selecting Features, you can select the language packages you want to install.
You can see a list of all Allplan languages included in your license.
After this, you can select the countries. Select the country packages you want to install.
Click ‘Next’ to confirm all other dialog boxes.

Note:Please note that the more country packages you select, the longer the installation will take and the more hard disk space will be required.




Using country packages in Allplan:
You must define the country when you create a project. You cannot change the country later.

Creating a new project:
When creating a new project, you can select the county in country-specific templates.
Select the country and the template you need.



If you do not select a project template, you must select the required country in the next dialog box.




In the project:
The status bar shows the country set for a project.


The units for length entries and reinforcement set in the 
Options are project-specific settings. These units are preset depending on the country selected.



Important note:	When checking out a project in a workgroup environment, you can choose which country-specific office standard you want to check out.
	Click 
in the ‘License Settings’ to see which countries are included in your license.
	There is a default country, which is usually the country entered in your license. Setup always installs the data for this default country in the STD and ETC folders. During installation, Setup creates a STD.??? folder and an ETC.??? folder for each additionalcountry package selected (??? stands for the country code). The office path and default path are always based on the country set for the project that is currently open. That is to say, when you open a project and save a favorite or library element in the office path or default path, these elements will only be available in projects with the same country settings. ProjectPilot is an exception; here, the office path and default path always refer to the STD and ETC folders.
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			Question:

How is a silent installation of Allplan carried out?




Answer:

From version 2022, Allplan is installed via Windows Installer.
The Windows Installer has a number of advantages, such as the ability to repair and provide the installation in a network. Allplan can also be installed unattended ("quiet") using the Windows Installer.

Please note that no individual support can be provided for this procedure.


The following steps are necessary:


1. editing the settings file

The attached settings file must be edited in advance to select the desired programme components.

Structure:
- Installation Options:
Set the desired installation option:
 
New installation:
No data will be taken over from the most recent previous version.
Value to be entered:
Upgrade.UpgradeNew
 
New installation with data copy:
Allplan is installed parallel to the previous version and the data (with the exception of the projects !) is copied.
Projects can be transferred to Allplan itself after the installation is complete.
Value to be entered:
Upgrade.UpgradeKeep
 
Upgrade:
The latest available Allplan version is transferred to the current version.
Upgrade.Upgrade
 
 
· Paths:
Enter the desired program folder under "InstallPath" and the desired central file storage folder for Allplan under "CentralPath".

Example:
InstallPath=C:\Program Files\Nemetschek\Allplan_2022
CentralPath=D:\Nemetschek\Allplan_2022

Important:
In case of upgrade, be sure to specify the paths of the previous version.
- Countries and languages:
Select the countries and languages to be installed from the list of suggestions in the file.
Define the main country with "DefaultCountry" and the main language of the installation with "DefaultLanguage".
If desired, add further countries and/or languages.
Important: For a functional installation, the main country and main language must be specified.
Example:
# Country list: AUS AUT BEL BRA BUL CAN CHN DEU ENG FRA GRC HOL HRV ITA JPN KOR POL PRT RUM RUS SLK SPA SVN SWI TCH TRK UNG USA VNM YUG
# Language list: BUL CHN DEU ENG FRA GRC HOL HRV ITA JPN POL PRT RUM RUS SER SLK SPA SVN TCH TRK UNG VIE
DefaultCountry=DEU
DefaultLanguage=DEU
Country.ITA
Language.ITA
 
- Advanced functions:
From the list of suggestions in the file, select those functions that are to be installed.
Example:
# Feature list: HelpFiles Fixtures TextureFiles Bft Demos
Feature.Fixtures
Feature.HelpFiles
Feature.TextureFiles
 
- Manufacturer-specific user data:
Select the user data to be installed from the list of suggestions in the file.
Example:
# Vendor list: Ancon Ancotech Armaturis Bartec Coupler Einbauteile Erico Filigran Halfendeha Halfenhbs Hrc Leitungskataster Lindab Peikko Philipp Reidbar Rolltec Sah Schoeck
Vendor.Ancon
Vendor.Ancotech
Vendor.Armaturis
Vendor.Bartec
Vendor.Coupler
Vendor.Einbauteile
Vendor.Erico
Vendor.Filigran
Vendor.Halfendeha
Vendor.Halfenhbs
Vendor.Hrc


2. storage of the installation and the settings file on a share (optional)

In order to be able to roll out the Allplan installation efficiently on all computers, it is recommended that both the Allplan setup and the settings file are stored on a share in the network to which all computers concerned have access.


3. selection of the installation option
You can choose between the following installation options:

- Quiet installation: Installation takes place without the need for user input.
- Passive installation: The installation takes place with reduced user input.

4. Installation
The installation is called up in the unpacked 'Allplan' folder by the file 'Allplan_Installer.exe' via the following command line entries:
 
- For Quiet installation:
Allplan_installer.exe /Settings <path-to-settings-file> /quiet.
 
Example:
\\SERVER\Freigabe\Unterordner\Allplan_Installer.exe /settings \\SERVER\Freigabe\Unterordner\settings.txt /quiet
 
- For passive installation:
Allplan_Installer.exe /Settings <Pfad-zur-Settings-Datei> /passive
 
Example:
\\SERVER\Freigabe\Unterordner\Allplan_Installer.exe /settings \\SERVER\Freigabe\Unterordner\settings.txt /passive
 
5. modifying the installation
It is also possible to modify the installation.
To do this, edit the settings file for the desired additional components or components to be removed.
Call up the setup with the following parameters:
 
- For Quiet installation:
Allplan_Installer.exe /Settings <Pfad-zur-Settings-Datei> /quiet /modify
 
Example:
\\SERVER\Freigabe\Unterordner\Allplan_Installer.exe /settings \\SERVER\Freigabe\Unterordner\settings.txt /quiet /modify
 
- For passive installation:
Allplan_Installer.exe /Settings <Pfad-zur-Settings-Datei> /passive /modify
 
Example:
\\SERVER\Freigabe\Unterordner\Allplan_Installer.exe /settings \\SERVER\Freigabe\Unterordner\settings.txt /passive /modify
 
6. repair of the installation
It is also possible to repair the installation.
Call up the setup with the following parameters:
 
- For Quiet installation:
Allplan_Installer.exe /Settings <Pfad-zur-Settings-Datei> /quiet /repair
 
Example:
\\SERVER\Freigabe\Unterordner\Allplan_Installer.exe /settings \\SERVER\Freigabe\Unterordner\settings.txt /quiet /repair
 
- For passive installation:
Allplan_Installer.exe /Settings <Pfad-zur-Settings-Datei> /passive /modify
 
Example:
\\SERVER\Freigabe\Unterordner\Allplan_Installer.exe /settings \\SERVER\Freigabe\Unterordner\settings.txt /passive /repair
 
7. uninstallation
The uninstallation can also be done via passive or quiet installation.
 
Call up the setup with the following parameters:
 
- For quiet installation:
Allplan_Installer.exe /Settings <Pfad-zur-Settings-Datei> /quiet /uninstall
 
Example:
\\SERVER\Freigabe\Unterordner\Allplan_Installer.exe /settings \\SERVER\Freigabe\Unterordner\settings.txt /quiet /uninstall
 
- For passive installation:
Allplan_Installer.exe /Settings <Pfad-zur-Settings-Datei> /passive /uninstall
 
Example:
\\SERVER\Freigabe\Unterordner\Allplan_Installer.exe /settings \\SERVER\Freigabe\Unterordner\settings.txt /passive /uninstall
 
Note on downloading the full set-up from version 2023:
From version 2023, Allplan is installed using the minimal installer, which only downloads those components that are actually required for the installation.
If, for example, the complete installation package with all optional components is required for rolling out the setup, it can be downloaded via the layout mode described below. Of course, the name of the "Installer.exe" must be changed to the actual name (e.g.:Allplan_2023_0_0_Installer.exe) in Silent Setup:

https://connect.allplan.com/de/faqid/sc-000007942.html


Note Licensing:
As there will no longer be a licence query in Allplan Setup from 2022, this information cannot be provided.
If a licence server is in use, it can be set up on a computer and then distributed using the following procedure.

https://connect.allplan.com/de/faqid/sc-000007100.html
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			Question:

How can I work from home with Allplan without a direct LAN connection to a common file storage folder?



Answer:

1. Working from home with direct access to the central data 


If you want to work together on projects, you can use Allplan Share, Allplan’s cloud solution, to work with Allplan without a LAN connection to the central file storage folder. This is only possible if Allplan is installed as a standalone version on a computer without access to a central file storage folder; otherwise, Allplan does not start. If the computer is part of a workgroup installation, the computer must be checked out and used outside the LAN (like a standalone workstation). Data access is via cloud services. 
This is only possible if you use Allplan Share for cloud storage.

Working with Allplan Share is just as simple as working at a standalone workstation. You and several other users can access and edit a project at the same time.

To get more information on Allplan Share, use the following link or contact your sales partner:

https://www.allplan.com/de/add-ons/allplan-share/


You can also find further information on Allplan Connect; use the following link:


https://connect.allplan.com/de/forum/themen/topic/topics/cad-allgemein-1/moderierter-sammelbeitrag-zugriff-auf-allplan-projekte-aus-dem-homeoffice-via-allplan-share.html


Note: 

VPN is not useful for common project storage.
Allplan exchanges many files with the data server. VPN uses advanced encryption, which considerably slows down data transfer.
A connection via VPN is not approved for Allplan because data might get damaged even if the connection is interrupted only briefly. In addition, working over the internet is extremely slow if the internet connection is not fast enough (at least 100 Mbit).
Allplan does not support a VPN connection with IPv6; Allplan detects only IPv4.
Make sure that the VPN connection does not switch to sleep mode. 

Please note that we cannot provide support for this constellation.



2. Working from home without access to the central file storage (working locally):



2.1 Allplan with workgroup manager:

If workgroup manager is included in your license, you can check out a computer or laptop with projects from the workgroup environment. You can then work from home without access to the server. The projects on the computer or laptop that is checked out are locked for the CAD users on the network. These users see the comment you entered when you checked out the computer.

You can find instructions at


https://connect.allplan.com/en/faqid/20160923105251.html

When you use a license server, you can get the license via a VPN connection or borrow the license beforehand:


https://connect.allplan.com/en/faqid/20180109095437.html

https://connect.allplan.com/en/faqid/20160523165423.html




2.2 Allplan without workgroup manager:

Using the office computer
If you have neither workgroup manager nor network access, you must uninstall Allplan and install it again by specifying the local paths. To work with a project, you must back it up and then import it to the local installation.

Using a new (private) computer
If you want to use a new computer to work from home, you must return the license at the office computer and then use this license to install Allplan on the new computer.


We recommend that you do not mix data from the office computer and the private computer. Merging data later involves considerable time and effort.

Use the following link to find out how to transfer projects:


https://connect.allplan.com/en/faqid/20180507154505.html
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			Task: 

You would like to export your Allplan 3D animation model and present it to somebody who does not work with Allplan.



Preparation:

Install a plug-in for Internet Explorer on the computer where you want to view the 3D data. Using this plug-in, you can open VRML files.

Plug-ins of this kind can be found on the Internet. Visit the website of Parallelgraphics, for example.
This plug-in is available for the following browsers:
Internet Explorer 6.0, Netscape Browser 8.0, Mozilla Firefox 1.5, Opera 8.5 or later versions.

http://www.cortona3d.com/Products/Cortona-3D-Viewer.aspx



Solution:

Open an animation window in Allplan.
Select File->Export ->Export to Cinema 4D/VRML/3DS/U3Dand save the data under any name in Windows Explorer. 
It is advisable to save the file in an empty folder as the textures used in Allplan are copied together with the VRM fileto this folder. 
You can then view the VRML file in Internet Explorer. All you need to do is double-click it. The functions provided for navigating and zooming are similar to those you can use in Allplan's animation window.



Note:

The Export 3D PDFtool is provided on the animation window's shortcut menu in Allplan 2008 and later versions. You can use Adobe Reader Version 2008 and later to view PDF files created in this manner.
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			Question:

I would like to install Allplan, which requires a Product Key. How can I install Allplan or activate the Product Key later? 


Answer:

Allplan is using since version 2016 a new protection system. Licensing is based on CodeMeter by Wibu Systems AG since then. You can no longer use Softlock or hardlock with Allplan 2016 and higher.
Allplan requires a Product Key. Using this key, you can activate your license online. The Product Key is a unique, 26-digit character string. You can use it to activate a license for Allplan.
You can find your Product Key in Allplan Connect. Go to http://connect.allplan.com/license
Note: The license is downwards compatible til version Allplan 2016 even if a higher version is displayed.

You can activate a license while you are installing Allplan or after you have installed Allplan. By activating a license, you connect the license with the computer. As a result, you can start Allplan on this computer.
The easiest and quickest way to activate a license is to do this online. In other words, the computer has Internet access.
To activate the license during installation:
Start Setup and follow the instructions displayed.
	In the 'Installation Option' dialog box, select the Licenser activationoption and click Next.
	Enter your Product Key.
	Click Activate license.



To activate the license after installation:

	Open the 'License settings' dialog box: Services application -> Utilities -> License settings.
	Click License activationon the left.
	Enter your Product Key.
	Click Activate license.



Notes:

You can find your Product Key in Allplan Connect. Go to http://connect.allplan.com/license
Click Profile -> License administration. 
Only administrators can use this function.


Step-by-step guide as a film:
You can watch a film about the new licensing system. To do this, go to: https://connect.allplan.com/de/support/loesungen.html
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			Information:

This document provides further information on installing Allplan 2019.

Backing up and archiving data:

We strongly recommend that you back up and archive all your data before you upgrade to Allplan 2019.


How to install


You can find detailed instructions on how to install Allplan 2019 in the following places:

- After you have downloaded and unzipped Allplan 2019, you can find the ‘install.chm’ file in the following folder: C:\Users\Public\Documents\Allplan 2019\HelpFiles\English.

- Use the following link:
https://webdrive.allplan.com/s/4LrjrymoxESzC6p and open the General\Installation help\2019 folder.


Please read these instructions before you install Allplan 2019.

System requirements for Allplan 2019

https://connect.allplan.com/en/faqid/20180608093815.html

How to handle licenses when upgrading to Allplan 2019

https://connect.allplan.com/en/faqid/20180608092654.html



Some notes on installing Allplan 2019

If you want to switch from Allplan 2016/2017/2018 to Allplan 2019, you can choose between three installation options. We recommend using the second option: first-time installation and copy data from Allplan 2016/2017/2018.

1. First-time installation

This option installs Allplan 2019 to a new folder without affecting any other Allplan installation (2018 or earlier). Setup does not transfer any data or settings to the new installation.

If you want to transfer data later, you have the following options:

You can uninstall Allplan 2019 and then upgrade from Allplan 2016/2017/2018.
You can integrate the data manually (requires administrative knowledge).

2. First-time installation and copy data from version

This option installs Allplan 2019 to a new folder without affecting any other Allplan installation (2018 or earlier). You can configure Setup to automatically copy the office standard (\std), projects (\prj) and user data (\usr) from Allplan 2016/2017/2018 to the new installations folder.
This duplicates the data: You can use all projects, defaults and resources both in Allplan 2018 and in Allplan 2016/2017/2016. This way, you can test the new version without losing your 'old' Allplan version.
Bear in mind, though, that you should not mix data from different versions. Merging data later involves considerable time and effort.

2a. Continue with first-time installation and copy data from version

This option is available when you have already used the second installation option to install <Product_Version> to a computer that accesses the same data server. As a result, the data are already available.

3. Upgrade and transfer data from Allplan 2016/2017/2018

This option installs Allplan 2019 to an existing folder, converting Allplan 2016/2017/2018 to Allplan 2019 and transferring all important settings. Afterwards, you can no longer work with Allplan 2016/2017/2018.
This does nor affect earlier Allplan versions (Allplan 2015 or earlier).


Installing on a network:

	If you work in a network environment (one common central file storage folder), you must upgrade all workstations to Allplan 2019. Beforeyou start installing, make sure that all workstations can be upgraded. For technical reasons, it is not possible to mix installations of different major releases. Any related problems area not covered by service contracts.

	During the upgrade, Allplan 2016/2017/2018 must not be running on any workstation.

	When installing with Workgroup Manager, make sure all workstations are checked in before you start upgrading.





Converting the data:

Data from earlier Allplan versions need to be converted to version 2019. Allplan 2019 automatically converts the data of a project you open. Click here for instructions on how to convert all projects in a single operation: 

https://connect.allplan.com/en/faqid/20090408124904.html


IBD 2019

Click here for instructions on how to get your activation codes for Allplan IBD:

https://connect.allplan.com/en/faqid/20110912113530.html
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			Question:

What can I do if Allplan no longer starts after I have upgraded and the following messages appear?
Allplan
Stop
...

After this, Quality Reporter displays an error report.



Answer:

Exit Allplan on all workstations and do the following:
Open the Services application and make a note of the path to the 'central file storage folder', which is displayed in the Services application window.
In addition, check whether the workgroup manager line is followed by 'Yes' or 'No'.

Open the central file storage folder in Windows Explorer.

If the workgroup manager line is followed by 
'Yes', open the NET subfolder.
'No', open the PRJ subfolder.

Find the 'project.dat' or 'project.Dat.xm' file in the NET or PRJ folder and rename it 'project-old.dat'.

After this, do the following:
Services application -> Service -> Hotline Tools -> reorg -> OK -> Restore project management file  -> OK
The program creates a new, correct project management file and you can start Allplan again.



Note:

If you come across error messages while doing this, please email the following information to support@allplan.com:

	Describe exactly what you did before the error or crash occurred.

	The error message itself (as a screenshot).

	The log file (trace).
https://connect.allplan.com/en/faqid/0001a27a.html

	A Hotinfo support request with question 01. 
https://connect.allplan.com/en/faqid/20130823123806.html
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			Question:

I have used the "Check out" tool to check out the computer from the network and remove the network connection. 
Why is Workgroup Manager no longer working?



Answer:

Windows disables network functionality as soon as you remove the network connection (unplug the network cable).
Running Allplan, however, requires specific network protocols (even if the computer is checked out).



Solution: 

To make sure that the operating system's network functionality is not interrupted, you can install a virtual network interface card. 
Microsoft provides a driver for this (loopback adapter).

How to install:

Windows 8/10:
Right-click the Windows Start button -> select "Run".
Type in "hdwwiz" in the search field. Right-click the program found -> select "Run as admin".
Click Next -> select the required hardware manually in a list and install it -> click "Next".
Select "Network adapter" in the list -> click "Next".
Select "Microsoft" in the list on the left -> "Microsoft loopback adapter for KM TEST" is presented for selection on the right -> click "Next" -> click "Next".

Windows 7:
Click the Windows Start button -> type in "hdwwiz" in the search field. Right-click the program found -> select "Run as administrator".
Click Next -> select the required hardware manually in a list and install it -> click "Next".
Select "Network adapter" in the list -> click "Next".
Select "Microsoft" in the list on the left -> "Microsoft loopback adapter" is presented for selection on the right -> click "Next" -> click "Next".

Windows Vista:
Start the "Hardware Wizard" by selecting 
Start -> Control Panel -> Hardware and clicking Continue -> Next.
Select "Install the hardware that I manually select from a list (advanced)" in the box and choose "Network adapter" in the list that follows.
This selects and installs the "Microsoft loopback adapter".



			
		

	




		
			








	
		
			
				
					
					No valid license available
				

				

			


			

				
					
						  Link
					
					

					
					

				

			

		

	


	

		
			
				
					Version: 
					Allplan 2024, Allplan 2021, Allplan 2017, Allplan 2023, Allplan 2019, Allplan 2016, Allplan 2022, Allplan 2020, Allplan 2018

				
				
				 | Last modified: 27.02.2024 12:08
				
			

			
				
						 

							
								
							

						 rate

						

					
			

		

		
			

			Question:

I have installed a Windows update. Now the license is no longer available.
When I start Allplan, I can see the following error message: "This license is no longer available" or "CmActLicense runtime system is not installed!" How can I restore the license?




Answer:

CodeMeter Control Center always saves the license to a container with the number  Allplan GmbH 128-XXXXXXX on your computer.

Start CodeMeter Control Center:
Open the Windows start menu and select CodeMeter -> CodeMeter Control Center. As an alternative, open Search by clicking the Search button on the Start screen and enter Codemeter.
Check the Licenses area to see whether there is the following container: Allplan GmbH 128-XXXXXXX.
The container must have a blue-green symbol 
and not a red symbol 



Work through the following steps:

Step 1 Restart CodeMeterService
The local Windows service, which is used by licensing, must be running.

Restart this service:
CodeMeter Control Center -> Process -> Start CodeMeter Service
If the service is running, stop it and restart it.

Now check whether the Allplan GmbH 128-XXXXXXX container is displayed.

If this has solved your problem, all you need to do is exclude Codemeter from virus scans as described in the following document: https://connect.allplan.com/en/faqid/20151209133620.html

If the container is still not visible, go to step 2.


Step 2  Contact Support
Send the following information for analysis by e-mail to support.de@allplan.com:
If the container is not displayed, or is still displayed with a red symbol, please send us

1. a screenshot of the Codemeter Control Center. License tab. 
Either found in the Windows Start menu via CodeMeter -> CodeMeter Control Center. Or enter Codemeter in the search bar on the start page.

2. the computer name from which the screenshot was taken. (can be found on the start page of the Allmenu->second line "Computer Name")

3. the license/workstation number, or the product key used
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			Question:

I activated my license offline. Now I would like to update this license or get the license for the new version. 
What can I do? 



Answer:

To update the license, you can use CodeMeter Control Center.

Start CodeMeter Control Center.
To do this, use the Windows start menu and select CodeMeter -> CodeMeter Control Center. An an alternative, go to the Windows search box and type Codemeter. 

You can find the container numbers in the ‘License’ area. Make sure your license container is included in this list. 
For license server licenses, this is an Allplan CM6 container with the number 130-XXXXXXX.


Note:
If there is only an Allplan GmbH container with the number 128-XXXXXXX, your license server is too old. In this case, proceed as described here: https://connect.allplan.com/en/faqid/20160527114300.html. 


Select this Allplan CM6 container and click License updateon the right. Select Create license request. Create a *.WibuCmRaC file for your container. 

Take this file to a computer that is online.

Go to the following web page: 
http://lc.codemeter.com/59885/depot/index.php

Enter your Product Keyin the “Ticket” line and click Next. You can now see your license. 
Click Activate license.


You can see the new license update, which is selected. Click Offline License Transferat the bottom on the right.

You can now upload the *.WibuCmRaC file (Browse....) by clicking Upload license request now. This creates your license, which you can download by clicking Download license update file now. Install this license on your server.

To do this, open CodeMeter Control Centerand click File -> Importlicense. 
You can now see the updated license in the license settings.



Finally, upload the receipt file.
To do this, open CodeMeter Control Centeragain and select the Allplan CM6 container with the number 130-XXXXXXX.

Then click License update -> Next -> Create receipt. 
Create the receipt file for this container. 

Take this file to a computer that is online.

Upload this receipt file using the web page. 
Click Nexton the web page.
If you have already closed the web page, use the link given above and enter your Product Key once again. Then select Continue with license transfer.
Select the receipt file and click Upload receipt now.
Click OKto confirm. This completes license activation.


If you have several license server licenses, all these licenses can be in the same Allplan CM6 container. However, you must upload the license update fileand upload the receiptfor each Product Key or license to update all licenses.



Notes:
	You cannot use Allplan Connect to update licenses. However, you can activate licenses offline for the first time or return licenses using Allplan Connect. 

	Did you know that you can find details about you licenses in Allplan Connect at http://connect.allplan.com/license. Just load the details about the licenses displayed by clicking the information button at the end of a line.
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			Question:

What license issues do I need to consider when upgrading from Allplan 2021/2022/2023 to Allplan 2024?

Answer:

Installation options during Setups

Upgrade - program update with transfer of all project data, office and user settings.
The existing Allplan installation is upgraded to version 2024. If several Allplan versions are installed, only the latest version will be suggested for upgrade.  Projects, office and user settings are automatically transferred from 2021/2022/2023 to Allplan 2024. Allplan 2021/2022/2023 is then no longer available.

New installation without transfer of project data, office and user settings:
Existing Allplan installations remain unchanged. Office and user settings are not transferred to version 2024. You can import projects after installation using the following Allplan function:
New project, open-> Import projects.

New installation with transfer of office and user settings:
Existing Allplan installations remain unchanged. Office and user settings are automatically transferred from 2021/2022/2023 to version 2024. In the case of multiple installed Allplan versions, only the most current version is suggested for transfer. If you have installed with a central file store, make sure that you create a folder with a suitable share on your central file store (server) beforehand. This folder can then be selected as the "central file storage folder" during setup. You can import projects after installation with the following Allplan function:
Project new, open-> Import projects.



Depending on the licensing system you use, you need to consider different points.

There is no license request when installing Allplan 2024. Therefore, make sure in advance that your licenses are also suitable for this version, e.g. by purchase or a valid service contract.


1. Upgrade Allplan 2024 – stand-alone workstation

Your license for Allplan 2024 will be updated after installation, when you start Allplan 2024 for the first time. Start Allplan 2024 and you will be prompted to update the license. Select "Update now" here. The license is updated online. You can then start Allplan 2024 directly or close the license window.

Note: To install Allplan 2024 on a new computer, please read on connect.allplan.com/license within the menu item Information on Installation and Licensing the instructions Transferring license to a new computer.

You can find your Product Key in Allplan Connect as usual. Go to: connect.allplan.com/license

2. Upgrading Allplan 2024 with a license server

Start by updating your license(s) at the license server. After this, upgrade the clients. To do this, start the License Settings program on the server. Click License Activation on the left, and then click the license you want to update. Click Update License.
After the license(s) update, you can perform the Allplan upgrade installation on the client computers.

NOTE: Check the version of your installed license server on the server. Starting with the license server version 2016-1-4, the detailed version status (Build-ID) is displayed directly in the lower left corner of the License Settings program.
At least version 1.1196.xxx.xxx should be displayed here. If an older Build ID is displayed, then you still have an older license server in use. In any case, please update your license server. Download the software for the license server from the Allplan Connect service portal. Detailed instructions can be found at connect.allplan.com/license under the menu item Information on installation and Licensing' and the instructions 'Updating license server and licenses'.


Note: You can update the licenses only at a license server you have already installed. If you want to switch to Allplan 2024 and move the license server to a new server, please read on connect.allplan.com/license within the menu item Information on Installation and Licensing the instructions Moving license server to a new server.

You can find your Product Key in Allplan Connect as usual. Go to: connect.allplan.com/license
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			Question: 

How can I set up a computer where I can archive projects I do not need regularly?



Answer:

If you work with Workgroup Manager, you can add computers to the workgroup (Services application -> Workgroup Manager -> Administer projects and computers).

Initial situation:
You have set up a workgroup environment 
and a computer you want to use as the archive. You do not need to install Allplan on this computer.

Preparation:
Create a new folder (..\Archive) on the archive computer. Share this new folder.
Create a subfolder (..\Allplan) in this new folder. Then create two more subfolders (..\PRJ and ..\USR) in the ..\Allplan subfolder.

Adding the archive folder to the workgroup:
Open the Services application and select
Workgroup Manager -> Administer projects and computers.
In the 'Remote projects' column on the left, right-click in the empty white space. The shortcut menu opens. Select 
Add any computer to Allplan Workgroup 
Find the archive computer in the list. Select the 'Archive' folder you just created and shared as well as the 'Allplan' subfolder.

Archiving:
Move the projects you want to archive to the archive computer. You can use drag-and-drop operations or 'Cut' and 'Paste' on the shortcut menu.



Summary:

	Using the admin tools, you can move projects to the archive computer.
	You do not need to back up the archive folder every day, as you do not edit the projects.
	It is not necessary that the computer is up and running.
	Switch on the archive computer before you upgrade. When you convert the project data of all projects, Allplan includes archived projects, making sure all projects are up-to-date.
	You can now use the project filter in Allplan to access the archive computer. To do this, open the File menu -> New Project, Open Project. Open the project filter and add all the computers of which you want to see the projects to the filter conditions.




Note:

You cannot create the archive folder on the server with the Allplan data, as you can add only one shared folder per computer.
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			Question:

What does this error message mean and how can I fix it? How can I change the path and switch from server to local?


Response:

For the use of Allplan Share, a defined path for the "LocaldataPath" is used for the temporary storage of the project data to be edited. Since Allplan 2021, a default setting has been made that the LocaldataPath should always be in the Windows user. However, for customers who place their users on the server or in the cloud, the problem arises that 80 characters are exceeded. There is a possibility to change this path to local by creating a registry entry.

Notice:

The procedure described below is carried out at your own risk.
Questions about this should definitely be clarified before practical implementation.
Always make a copy of a file before making changes to it.
Before changing registry entries, create a backup of the registry key to be modified by exporting the key in the registry editor under File->export....
We recommend that this work be carried out by an experienced technician.


Proceed as follows:

Be sure to close Allplan before making the change so that no data loss or errors can occur.

1. Create a new folder on a local drive C: or D: of the computer used for Allplan with the name "Local data" and the subfolder "Allplan" (e.g. C:\Local data\Allplan) .
2. In Windows, as administrator, start the Windows Registry Editor (Start-> Run-> Regedit).
3. In the registry, open the key of your version in the left column:
HKEY_LOCAL_MACHINE\SOFTWARE\Nemetschek\Allplan\2021.0\InstallRoot
or e.g. HKEY_LOCAL_MACHINE\SOFTWARE\Nemetschek\Allplan\2022.0\InstallRoot
...
4. In the right-hand window, click with the right mouse button and select New -> String.
Create a string with the name LocalDataDrive and a string with the name LocalDataPath.
5. In the right column of the registry editor, double-click the left mouse button to activate the edit mode for the "LocalDataDrive" key and enter the drive you have selected for the local file storage (e.g. C: ) and confirm the change with "OK". The change in the registry editor is then applied.
6. Then activate the editing mode for the key "LocalDataPath" in the right column of the registry editor by double-clicking the left mouse button and enter the additional path defined for the local file storage (e.g. \LocalDataPath ) and confirm the change with "OK". The change is then adopted in the registry editor. The result should look like this:




7. Close the Registration Editor. Allplan now uses the newly defined path for the Allplan Share cache.
Restart the Allmenu and you will see the local path displayed there.
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